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Chapter One - Introduction 

Welcome 
Event Logger is a GE MULTILINTM PMCS tool that helps you increase 
productivity, reduce downtime, and improve power quality by automatically 
collecting, displaying, and organizing event and alarm data from devices in your 
power network. You configure Event Logger to interrogate selected devices in your 
system, asking if they have any alarms or events to report. Event Logger uses this 
information to display a real-time list of events and alarms as they occur in your 
system and automatically writes this critical information to a database file. All of this 
information includes accurate time and date stamps and provides the following 
benefits: 

• Faster corrective maintenance — Pinpoints the root causes of 
problems quickly using time-stamped alarms and sequence-of-events 
logs. 

• Less downtime — Helps you identify and correct problems before 
they lead to loss of power and/or costly damage to loads such as 
production equipment and computers. 

• Improved power quality — Helps identify sources of “dirty” power, 
otherwise invisible, and allows you to take corrective action to prevent 
and possible damage to critical equipment. 

• Higher productivity — Frees up maintenance and repair personnel to 
perform other needed duties. 

• Increased safety — Provides a centralized source of information, 
which reduces the need for physical contact with equipment and shop-
floor presence. 

Event Logger collects event and alarm data from metering, control, and protection 
devices on the network. See PMCS Read-This-Book-First – the  Installation and 
Getting Started Guide, for a list of devices supported by PMCS and Event Logger. 
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About Event Logger 
The PMCS Event Logging system is made up of two components: the EventServer, 
which collects events and stores them in an on-line database, and the EventViewer, 
which provides an intuitive graphical interface for viewing, querying, and 
monitoring the database contents. The term "Event Logger" refers to both 
components together. 

The EventServer is the workhorse, constantly updating the database as events are 
reported from devices connected via Ethernet or Modbus RTU communications 
protocols. As the database grows, the EventServer creates archive files of the oldest 
events, preserving events for review while maintaining a manageable online 
database size and maximizing system performance. 

The EventViewer is easy to use. It provides a friendly Windows interface, with 
toolbars and pull-down menus for quick and easy selection of many pre-configured 
views of your data. There are also provisions for creating custom views of your data 
as well. 

This release of PMCS supports the devices listed the PMCS Read-This-Book-First - 
Installation and Getting Started Guide. 

Alarms and Events 
An alarm is the highest priority message and indicates a condition in the network, 
such as a circuit breaker tripped, a circuit breaker in pickup, or a setpoint threshold 
crossed. Depending on the severity of the condition, this alarm may be 
acknowledgeable or unacknowledgeable. 

Events are lower-priority information that usually indicate a status change, such as a 
notification that the requested waveform capture has occurred, or an internal 
communication error with a device has been detected. 

Installation 
To install Event Logger, refer to PMCS Read-This-Book-First, the Installation and 
Getting Started Guide, which contains installation procedures for all GE 
MULTILINTM PMCS software packages. There you will find details on installation 
options that enable you to configure your event logging system either as a 
conventional program, or as a Windows NT Service. Running EventServer as a 
conventional program provides a system that is easy to use and configure.  

Event Logger also requires ODBC32, the Microsoft Access driver Version 
3.50.360200, and MSDE database. Both the ODBC32 driver manager and the 
Access driver are installed as part of the Event Logger installation.  
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Event Logger Databases 
 

The Event Server stores events to a EVENTLOGGERSQL.MDF database. The 
MSSQL7/Data is the default directory that contains the events logged by the Event 
Server since the last archive was generated. The events in this database can be 
viewed in the Event/Alarm Viewer display windows, described later. Events 
acknowledged via the Event/Alarm Viewer user interface are acknowledged in the 
database; deleted event records are retained in the database, but are not visible in the 
Event/Alarm Viewer.  

 

 

Event/Alarm Viewer 
Event/Alarm Viewer enables you to view the contents of a "live" Event Logger 
database that is actively receiving events from the EventServer application, or an 
archive file of older events.  

To run Event/Alarm Viewer, either select the Event/Alarm Viewer icon from the 
Start Menu (it’s located in the PMCS group) or execute the program from a 
command line. For example: 

\GE_PMCS\Eventlog\Eventlog.exe. 
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Chapter Two - Overview 

Get going with Event Logger 
The Event Logger program has been designed to be as user-friendly as possible. The 
instructions in this chapter walk you through the basic setup and use of the Event 
Logger, step by step. If you’re familiar with the PMCS DDE/OPC Server and your 
network and devices have been properly configured, this chapter will get you up to 
speed in a matter of minutes. 

The basic procedure to configure and operate Event Logger consists of these four 
steps. 

1. Make sure the PMCS DDE/OPC Server is running. 

2. Start the Event Server client. 

3. Configure Event Server to query any DDE Servers and devices whose 
alarms/events you wish to see. 

4. Use Event Log to observe and filter the alarms and events as they appear. 
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Make sure the PMCS DDE/OPC Server is 
running. 

The PMCS DDE/OPC server should be running before you start Event Server. If the 
DDE Server is not running when you attempt to launch the Event Server, a system 
event is logged indicating the failure to connect to the specified servers or topics. 

When the connection to the PMCS DDE/OPC Server is made, you should see an 
event similar to the one shown below.
 

 

For purposes of this text, we’ll assume that you’ve already correctly configured the 
PMCS DDE/OPC Server with the devices connected to your network. If you have 
any questions regarding setup or launching of the PMCS DDE/OPC Server, please 
refer to GEH-6510, PMCS  Network and Device Configurator User’s Guide. 
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Start the Event Server client. 
To access Event Server, open the PMCS program group in Windows or select the 
EventServer icon from the PMCS section of the Start menu. The Event Server 
program icon, labeled Event Server, is shown below.  

 
Click on the icon to start the Event Server program. If the icon is not present on the 
Start menu, either the EventServer was not installed, or it was installed as a 
Windows 2000 SP4 service. See the next section for information on starting and 
configuring the EventServer service. 

The Event Server main window will appear: 
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Configure Event Server 
The Event Server must be configured to know which devices you want to monitor 
for events and alarms. Every device on the network should have been configured 
with a device name at the PMCS DDE/OPC Server and every other DDE Server in 
the system. By telling the Event Server which Servers to watch and the names of the 
devices you’re interested in, the Event Server will know which devices’ events it 
must store. 

It’s a good idea to have on hand a list of the devices whose events and alarms you 
wish to see. You’ll need the exact topic name given to each device at the PMCS 
DDE/OPC Server, and you’ll need to know the device type as well. You also need to 
know the name of the DDE Server you’ll be accessing. 

If the EventServer is actively logging information into the database you’ll need to 
stop it before changing the Server configuration information. Click on the toolbar 
STOP button to halt logging. 

Select Configure:Servers or click on the Servers icon in the Event Server main 
window: 

 

The Configure Server dialog box appears: 

 

Click on the checkbox in the list of Configured Servers to enable the desired server. 
If the PMCS DDE/OPC Server is not listed, enter the name of the DDE Server 
application you are using in the Server Name textbox and select type “GE DDE.” 
Then click on the Add icon to transfer the new server to the list of Configured 
Servers. If you are using the GE 7700 Gateway Server, add it to the list as a Generic 
DDE server. 
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If you wish to log waveform events from the GE Waveform Server, enter the Server 
Name as “WFSERVER”, select Type “GE Waveform” and click OK. Note that 
device names need not and cannot be added to a GE Waveform Server connection.  

NOTE: If the Server is running on the same machine as Event Logger, the name will 
be either GE32XXXX. If you are operating the Event Logger client on a remote 
machine and accessing the PMCS DDE/OPC Server via NetDDE, the name will 
have the format \\computer_name\server_name. If you are not sure where the PMCS 
DDE/OPC Server is located, contact your system administrator. 

When you have added the PMCS DDE/OPC Server to the Configured Servers list, 
select the OK button to return to the Event Logger main window. 

Now select Configure:Device:Device Name to display the Device Name Config 
window: 

 

Select a server from the Configured Servers pull-down list. If you select one of the 
standard GE DDE servers such as GE32MODB, a button labeled "Get Config Info" 
appears. Clicking this button will cause EventServer to automatically retrieve device 
information from the DDE server and load it into the EventServer’s configuration. 
Generic DDE servers do not support this automatic feature and require manual 
device configuration. To add a device manually, click the "ADD" button to display 
the Add dialog: 
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Enter the device name and select the matching device type from the drop down list. 
Click OK when all the device parameters are entered. 

The Device Name Config dialog now shows the devices added for this server. You 
can customize each device’s configuration further – select a device from the list by 
clicking it to display additional device configuration fields. 

 

By default, the device is activated and no name is entered in the Display Name field. 
If you would like a name other than the device name displayed in the EventViewer, 
enter it here. If you want to disable a device so that events are not requested from it, 
uncheck the "Activate" checkbox. 

Click OK to save the new device configurations. 

NOTE: Event Server does not allow Display Names of more than 10 characters. The 
PMCS DDE/OPC Server supports names up to 20 characters. When configuring the 
Server, make sure any devices to be used with Event Server are given Display 
Names of no more than 10 characters. 

Repeat this process until you have configured all the devices on your list, then click 
OK. Event Server will immediately connect to the PMCS DDE/OPC Server for 
information on the configured devices, inquiring if they have any alarms or events to 
report, and adding this information to Event Server’s databases. 
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Using your data 
As data are collected, you may want to sort and filter the data to see the particular 
information you are interested in. Event/Alarm Viewer allows you to instantly 
display complete lists of related information, to perform more advanced queries, and 
to sort the windows by device name, device type, date and time, and more. 

The Toolbar provides one-touch access to seven different report windows. Click any 
of the following buttons (or select the corresponding option from the View menu) to 
display one of the report windows: 

 
Button Window/Description 

 
Displays the Sequence of Events window. A selected set of events 
and alarms are displayed in sequential order, with the most recent 
displayed first.  

The  button allows you configure the set of events to be 
displayed in the Sequence of Events window.  

 
Displays the Device Events window; only device Events are 
displayed, most recent first. 

 
Displays the Device Alarms window; only device Alarms are 
displayed, most recent first. 

 
Displays the System Events window; only System Events are 
displayed, most recent first. System Events include such things as a 
user logging in or out of the system, a device or communications port 
failure, or a waveform capture failure. 

 
Displays the Waveform Events window; only Waveform events are 
displayed, most recent first. Waveform events record the successful 
completion of a waveform capture. 

 
Displays the Annunciator Events window; only Annunciator Panel 
events are displayed, most recent first. Annunciator Panel events 
include any device events which affect the Annunciator Panel tiles, 
as well as any events initiated by the Annunciator Panel Wizard. 

 
Displays the Fault Reports window; only Fault events are displayed, 
most recent first. These faults are events such as line faults or ground 
faults recorded by certain fault-sensitive devices. These devices are 
the LPS, ALPS, DFP100, DFP200 and SM-3. 

 

That completes our ‘Quick Start’ for the Event Logger software. We recommend 
that you read the rest of this manual to gain a more thorough understanding of the 
software and its capabilities. 
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Chapter Three - Event Server 
Menus and Toolbars  

What’s on the Event Server Screen? 
After you click the Event Server icon, the main window appears, as shown below: 

 
 

There are several helpful navigational and operational aids in the main window: 

• Menu bar – Access these pull-down items either with the mouse or by 
ALT+(letter) keystrokes. 

• Toolbar – Click control buttons to activate the most-often-used 
commands. 

• Status bar – The status bar is located at the bottom of the main 
window and provides messages about Event Logger’s current status, 
such as the presence of unacknowledged alarms.  

These controls are discussed in greater detail in the following sections. 

Where applicable, help icons appear below the cursor and in the status line at the 
bottom of the screen. These prompt an action or describe an object when the cursor 
lingers over an object. 
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Menu Bar 
The Event Logger main window displays the following pull-down menus: 

 

Explanations of each menu and its options follow. 

Operations Menu 
The Operations pull-down menu is shown below. Descriptions of the Operations 
options follow. 

 

Primary mode is the normal operations mode, running on the host PC, with two 
options: 

1. Press Start Logging to store all events in the database. 

2. Press Stop Logging to stop storing events in the database; this is 
necessary for system configuration. 

Backup mode allows copying events from the database on the host PC to the backup 
PC in a redundant system. 

Exit closes the application.  
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Configure Menu 
The Configure pull-down menu is shown below. The following options are 
available: 

 
Servers opens the Configure Servers dialog box for adding, deleting, activating, or 
deactivating your servers. You can also access this dialog box by clicking on the 
Servers button on the toolbar. 

Device Type opens the Device Types dialog box for modifying the default device 
information. This advanced feature allows you to customize the Alarm and Event 
definitions for the device. 

Device:Device Name opens the Device Name Config dialog box for adding, 
activating, and modifying device information. 

Device:Custom String opens the Device Name – Custom String dialog box for 
entering a custom message to be displayed when an event occurs. 

Annunciator Panel enables you to configure events corresponding to annunciator 
panel indicators in the PMCS Annunciator Panel Wizard, part of the User Screen 
Configurator package. The PMCS User Screen Configurator enables you to create 
custom Human-Machine Interfaces (HMIs) to access your power management data. 
One of the pre-packaged wizards replicates a traditional utility-style annunciator 
panel, which communicates with the Event Logger and displays indicators showing 
if selected events occur at or to specified devices. 

Logical Expressions opens a dialog box that allows you to add, delete, or modify 
the logical expressions for user-defined events. 

Archive Criteria opens a dialog box that allows you to specify the file path for 
storage of archived data. 

Redundancy allows you to specify the Data source name for primary and backup 
databases and the host for the backup in redundant server applications. 

Configuring Servers 
Select Configure:Servers or click on the Servers icon in the Event Server main 
window: 

 

The Configure Servers dialog box appears: 
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To add a DDE Server to the list of Configured Servers, enter the name of the DDE 
Server application in the Server Name field and select the type of DDE server 
(usually GE DDE), then click on Add.  

If you wish to log waveform events from the GE Waveform Server, enter the Server 
Name as WFSERVER, select GE Waveform, and click on Add. Note that device 
names need not and cannot be added to a GE Waveform Server connection. 

NOTE: If the PMCS Server is running on the same machine as Event Logger, the 
name will be either GE32MODB or GE32MTCP. If you are operating the Event 
Logger client on a remote machine and accessing the PMCS DDE/OPC Server via 
NetDDE, the name will have the format \\computer_name\server_name. If you are 
not sure where the PMCS DDE/OPC Server is located, contact your system 
administrator. 

When you have added the DDE Server to the Configured Servers list, select OK to 
return to the Event Server main window. 

To delete a server from the list, select the server name and click on Delete. 

Select the active server application by clicking on the appropriate check box in the 
list of Configured Servers. 
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Configuring Device Types 
All device types should be configured with event information before events are 
logged for any such devices. If this configuration is not performed, no descriptive 
information is displayed about incoming events for the device. This configuration is 
accomplished with either the manual or automatic options of Configure:Device 
Type. 

For manual configuration of device types. select Configure:Device Type:Manual 
or click on the Configure Device Type icon in the Event Server main window: 

 

The Device Types dialog box is displayed: 

 

The list of Configured Device Types is initially supplied with the names of all 
device types supported by Event Server. To add a new device type, enter the name in 
the New Device Type text box, then click Add to move the name into the 
Configured Device Types window. 

To configure a device type so that events are logged, select a device name in the 
Configured Device Types window and click on Configure to display the Device 
Type – Custom String dialog box: 
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To complete the configuration, click on Read CSV to access the appropriate 
configuration file. CSV files are found in the subdirectory 
GE_PMCS\Eventlog\ConfigFiles. Open the configuration file that matches the 
device type; the event information will appear in the Device Type –Custom String 
dialog. Click on Close to save the information to the database and return to the 
Device Types dialog. 

To add or change a custom message to be displayed when an event occurs or to 
change the Event Type or Log/Display status, double-click on the desired event 
line. This displays the Device Information dialog box: 

 

You can now enter the desired Custom string and change the other parameters, as 
desired. Click on OK to return to the previous window, with the new information 
displayed. 
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To enter a new event type, scroll down the list in the Device Type – Custom String 
window until a blank line appears. Double-click on the blank entry and the Device 
Information dialog box appears with all text fields available for entry. After you 
have finished entering or modifying all desired events, you can save the information 
as a new configuration file by clicking on the Write CSV icon. Click on Close to 
configure the device type by saving the event information in the Event Logger 
database. 

For automatic configuration of device types, select Configure:Device 
Type:Automatic to display the Device Type Automatic Configuration dialog, 
shown below. 

Select the path at which the device configuration (CSV) files can be found, normally 
GE_PMCS\Eventlog\ConfigFiles. In the Available Config Files window, select 
each device type to be configured and click on the right arrow icon to move it to the 
Selected Config Files window. When all the desired device type names have been 
transferred, click on Save Info to install the event information in the database. 

 

PMCS EventServer User’s Guide Chapter Three - Event Server Menus and Toolbars  •  23 



Configuring Device Names 
Select Configure:Device:DeviceName to display the Device Name Config dialog 
box: 

 

From the pull-down list of Configured Servers, select the GE DDE Server, then 
click on the Get Config Info button. All active devices configured in the GE DDE 
Server will appear in the larger display window. (Note: The Get Config Info function 
works only with GE DDE Servers; other DDE servers are not supported, and the 
button is not shown, as is the case in the above screenshot.) This function retrieves 
all the configured device information automatically, eliminating manual device name 
entry. 

To configure a device so that Event Server can begin logging events for it, select the 
appropriate device from the list of devices, and enter the Display Name in the 
textbox. Click on the Activate check box, then click on the Add icon to configure 
the device. Assigning a Display Name to a device is optional, allowing you to 
customize the device name for display in the Event Log. 

NOTE: Event Server does not allow Display Names of more than 10 characters. The 
PMCS DDE/OPC Server supports names up to 20 characters. When configuring the 
Server, make sure any devices to be used with Event Server are given Display 
Names of no more than 10 characters. 

Repeat this process until you have configured all the devices that you want Event 
Server to log, then click OK. Event Server will immediately connect to the PMCS 
DDE/OPC Server for information on the configured devices, inquiring if they have 
any alarms or events to report, and adding this information to Event Server’s 
databases. 
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Adding Custom Strings 
Event Server provides the ability for you to enter a custom message to appear as the 
message when an event occurs. Select Configure:Device:Custom String to display 
the Device Name – Custom String dialog box: 

 

To change the custom string for any device listed in the device window, double-click 
on the device name or select the device and click on Edit. The Device Name dialog 
box appears: 
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Enter the new message in the CustomString text box. You can also select the Event 
Type and how the event is handled by Event Server. Click OK to save the new 
definition to the database. 

To add a new device with a custom string, double-click on an empty entry in the 
Device Name – Custom String dialog box. The Device Name dialog will appear, 
this time with blank entries in all the text boxes. Select the DeviceName from the 
pull-down list, then enter the DeviceType, EventCode, and CustomString in their 
text boxes. Click on the appropriate buttons to select Event Type and also the 
Log/Display option to determine how the event will be processed by Event Server. 
Click OK to save the information in the database and return to the Custom String 
dialog. 

The Write CSV button saves the file with the device definition to any directory with 
any name. The Read CSV button allows you to read any of the previously 
configured device sets. 

Configuring Annunciator Panel Devices and Events 
 
Note: This feature is available only for selected versions of Event Server. The 
information mentioned in the section would not be relevant to all versions. 

Annunciator Panel Devices and Events are a feature of the Event Server that 
interacts closely with one of the PMCS Wizards. By itself, this menu item and its 
windows do nothing; in conjunction with the Wizard, it provides a utility-style 
annunciator panel interface for a PMCS network.  

NOTE: This manual explains briefly how to set up Annunciator Panel Items and 
Annunciator Panel Events that Event Server will track - in other words, the Event 
Server side of the relationship. The Wizard side of the relationship, the full theory of 
operation and instructions on configuring the Annunciator Panel wizard itself are 
contained in the GEH-6513  Interface Toolkit (Wizards Guide) for InTouch and 
DEH-210  Interface Toolkit (Wizards Guide) for Cimplicity. For complete 
instructions on configuring and using the Annunciator Panel wizard, refer to that 
document. 

Annunciator Panel Theory of Operation 
The Annunciator Panel wizard provides a screen full of indicator tiles, each relating 
to a particular device, event, or group of events. These tiles are displayed in different 
colors to indicate different alarm conditions. The Annunciator Panel wizard monitors 
selected DDE items in the Event Server and responds to changes of state in these 
items by changing the colors of individual indicator tiles. For example, you might 
configure a relay trip event to have a tile in the Annunciator Panel wizard. The 
wizard monitors a DDE tag at the Event Server corresponding to the trip status of the 
relay and displays a grey indicator if the relay is operating properly, and a red 
indicator if the relay has tripped. 

From the Event Server’s perspective, there are two parts to configuring the 
Annunciator Panel. First, each DDE Item that will be displayed on the Annunciator 
Panel wizard must be added (using the Add Items dialog). For the example we’re 
discussing, we’ll assume you’ve created a DDE Item named Trip1. Each DDE item 
will connect to an individual tile in the Annunciator Panel wizard.  

The second part consists of defining events which will turn individual DDE items 
ON or OFF. Each DDE item (or Annunciator Panel tile) can be turned on or off by 
any number of device events you define. The events are logically ORed together to 
determine ON or OFF conditions; i.e., if any of the events occurs, the DDE item is 
ON; if none of the events have occurred, the DDE item remains OFF. 
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We’ll continue the relay example we began above. For example, you might 
configure the Trip1 DDE Item to be ON if any of the following events occurs: the 
relay is tripped, or the relay reports an error condition, or the relay senses an 
overvoltage condition. The Annunciator Panel wizard displays a grey indicator tile 
for the relay for as long as the DDE item remains in the OFF condition. If the 
Annunciator Panel wizard sees the DDE Item change from OFF to ON, it reacts by 
changing the indicator tile from grey to red. The Event Server Annunciator Panel 
logic will also change the state of a DDE Item in response to actions performed at 
the Annunciator Panel Wizard. The user can both acknowledge and reset individual 
Annunciator DDE Items.  

The following diagram shows the relationship of the Annunciator Panel wizard, the 
Event Server, and the PMCS DDE/OPC Server. 

Annunciator Panel Wizard

Relay 1
(green)

Relay 2
(green)

Relay 3
(green)

PMCS
DDE Server

Annunciator Panel Wizard monitors DDE Items at Event Logger

Event Logger
tracks events
reported by
PMCS DDE
Server

Annunciator Panel Wizard

Relay 1
(red)

Relay 2
(green)

Relay 3
(green)

Event Logger

PMCS
DDE Server

Annunciator Panel Wizard monitors DDE Items at Event Logger

Event Logger
tracks events
reported by
PMCS DDE
Server

Event Logger

DDE Item Name: Trip1
Status: OFF

Configured Events Received
Relay Tripped? NO
Error Condition? NO
Overvoltage Condition? NO

Relay 1 

Relay 2 

Relay 3 

Relay 1 

Relay 2 

Relay 3 

DDE Item Name: Trip1
Status: ON

Configured Events Received
Relay Tripped? YES
Error Condition? NO
Overvoltage Condition? NO

 

In the upper illustration, the Event Server watches for any of the three events 
configured to cause a change of state to the Trip 1 DDE Item. None of these three 
events has occurred, so the status of the Trip 1 DDE Item is at OFF. The 
Annunciator Panel wizard is monitoring the configured DDE Items at the Event 
Server, but all DDE Items are “OFF” so the Annunciator Panel displays green 
indicator tiles. 
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In the lower illustration, the Event Server has recorded a “Trip” event for the unit in 
question, and changed the state of the Trip 1 DDE Item to “ON”. The Annunciator 
Panel wizard sees this change, and responds by changing the color of the 
annunciator panel tile for Relay 1 to red. 

 

Configuring Annunciator Panel Items 
Select Configure: Annunciator Panel: Items to display the Annunciator Panel 
Items dialog box. Note that Event Server must be in “running” mode, logging events 
to the database, for configuration of Annunciator Panel Items or Events. 

 

Here we add DDE Items for the Annunciator Panel wizard to monitor. 

Selecting the Add button displays the Annunciator Panel Items Add dialog box: 

 

Enter an Item Name, Description (optional), and Group for this item. Make note of 
the entries you make here, as you will need to use the exact name and group 
specified here when you configure the Annunciator Panel wizard. 

To modify Annunciator panel items, select the Item from the Existing Items list in 
the Annunciator Panel Items window and click the Modify button. Make any 
changes required to the Item Name, Description or Group fields, then click OK. 

To delete Annunciator panel items, select the Item from the Existing Items list in the 
Annunciator Panel Items window and click the Delete button. At the confirmation 
dialog, click OK. 
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Configuring Annunciator Panel Events 
Using the Event Logger’s Annunciator Panel Events dialog box, you supply the 
device name, the event code, and an ON/OFF selection for each device event driving 
the Annunciator Panel wizard. 

Selecting the Events button displays the Annunciator Panel Events dialog box: 

 
Here we define events that cause ON or OFF conditions for the individual DDE 
Items we defined earlier. Select an Item name from the pull-down list and select the 
Add button. The Annunciator Panel Events Add dialog box appears: 

 

The Item Name shows the currently selected DDE Item. Select a device from the 
Device Name pull-down menu and enter an event code to watch for. Finally, in the 
Action field, select whether this event will cause an OFF or ON condition in this 
DDE item. Choose OK to close the dialog box. 
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Configuring Logical Expressions 
Selecting Configure: Logical Expressions displays the Logical Expressions dialog 
box: 

 

To create a new logical expression, enter the name into the New Expression text 
box, then click on Add, to enter the name in the list of Available Logical 
Expressions. To configure a new expression or to modify an existing one, click on 
Configure, which displays the Logical Expressions dialog box, as illustrated below. 

Select the device names, event codes, and logical operators to define a user-defined 
event. Select the event type and the time interval during which all the device events 
must occur in order to trigger the new event. Click on OK to save the definition of 
the new event to the database. 
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Configuring Archive Criteria 
Selecting Configure: Archive Criteria opens the Archival Configuration dialog 
box: 

 

Clicking on the square button to the right of either text box opens a Windows 
directory dialog to specify the path for the location of the Archival Directory. 
Secondary Directory for archival is not supported in this release. Unchecking the 
EnableArchival can disable auto archival.  

NOTE: Disabling the Auto Archival would increase the Event Database Size and 
would lead to performance issues. 
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Configuring Redundancy 
 
 

Selecting Configure: Redundancy: Host opens the Primary Database 
Information dialog box: 

 

You can change the Data source name for the host database in the text box. If Access 
is the database program, the security features are not supported. If a different 
database program is active, such as MSDE, the system administrator can require that 
a User ID and Password be entered in order to make a change. 

The MSDE installation script will configure PMCS65 DSN to 
EVENTLOGGERSQL database.  

 

Selecting Configure: Redundancy: Backup opens the Backup Database 
Information dialog box: 
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You can enter a Data source name and Backup PC Name for the backup database. 
Security features are the same as with the Primary Database. 

Special Reports Menu 
 

The Special Reports menu enables you to retrieve and view fault reports from 
several fault-sensitive devices. 

View Menu 
The View pull-down menu provides the following options: 

• Status Bar shows or hides the status bar at the bottom of the main 
window. 

Help Menu 
The Help menu offers standard Windows functions to view help for the Event 
Logger program. 

The About EventServer... dialog contains the program version and copyright 
information. 
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Toolbar 
The main window toolbar contains the following icons: 

 

Click on an icon to perform the corresponding action, as described in the table 
below. 

Button Function/Description 

 
Starts the logging of events into the database when Event Logger is in Primary mode. 

 
Stops the logging of events into the database when Event Logger is in Primary mode. 

 
Opens the Configure Servers dialog box for adding, deleting, activating, or deactivating your servers. 

 
Opens the Device Type dialog box for configuring display names for devices. 

 
Opens the Logical Expressions dialog box for adding, deleting, or modifying logical expressions for 
creating user-defined events. 

 
Switches the Event Logger into Primary mode for data logging or configuration. 

 
Switches the Event Logger into Backup mode for copying the events database to the backup volume. 

 
Opens the Archival Configuration dialog box for specifying the directories for storing archives. 
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Security Support 
Event Server can be configured to require a password before a user may change the 
configuration, stop the logging of events, or close Event Server. To change whether 
a password is required, use the following procedure: 

1. Open the Windows Run dialog box (from the Start button), enter 
regedit into the Open: text box, and click on OK. 

2. In the left side of the Edit Registers window that appears, select the 
following directory path: 

HKEY_LOCAL_MACHINE\SOFTWARE\GE\PMCS\6.0\DataBase\Admin 

3. In the right side of the window, look for CloseEventLogger. If its 
current value is “0”, then password protection is turned off (this is the 
default), while “1” indicates that it is on. To change the setting, double-
click on the CloseEventLogger icon. 

4. In the Edit String dialog box, set the desired value (0 or 1), then click 
on OK. 

5. To set or change the password, double-click on the EL Password icon, 
enter the desired password in the Edit String dialog, then click OK. 

6. Close the Edit Registers window to save the changes, which are 
effective immediately. 

Whenever a user attempts to perform an action that is password protected, the Enter 
Password dialog box appears. Enter the current password and click on OK to 
proceed with the protected action. 

To change the password, either use Edit Register, as described above, or enter the 
password in the Edit Password dialog, then click on Change Password. Another 
dialog appears in which you are asked to enter the new password twice, then click on 
OK to confirm the change. 

Automatic Event Printing 
Event Server can be configured to automatically send the details on each event as it 
occurs to a connected line printer. To start or stop automatic event printing, use the 
following procedure: 

1. Open the Windows Run dialog box (from the Start button), enter 
regedit into the Open: text box, and click on OK. 

2. In the left side of the Edit Registers window that appears, select the 
following directory path: 

HKEY_LOCAL_MACHINE\SOFTWARE\GE\PMCS\6.0\EventLogger 

3. In the right side of the window, double-click on the Print entry to 
display the Edit String dialog box. 

4. To start automatic printing, set the value to “1”; to stop automatic 
printing, set the value to “0” (this is the default). Click on OK. 

5. Close the Edit Registers window to save the change, which is 
effective immediately. 
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Chapter Four – Event/Alarm 
Viewer Menus and Toolbars 

In this chapter, we’ll examine Event/Alaram Viewer's menu and toolbar items in 
detail, describing each of its functions and options. As in Chapter 3, we’ll assume 
that some buttons (such as OK and Cancel) are self-evident and that you can 
interpret their functions from general experience with the Windows interface. 
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What’s on the Event/Alarm Viewer Screen? 
After you click on the Event/Alarm Viewer icon, the main window appears, as 
shown below: 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Menu bar Tool bar 

Display Window Status Bar 

 

You can open additional child windows, but there must always be at least one 
window open for correct data transfer to the database. 

There are several helpful navigational and operational aids in the main window: 

• Menu bar – Access these pull-down items either with the mouse or by 
ALT+(letter) keystrokes. 

• Toolbar – Click these control buttons to activate the most-often-used 
commands. 

• Status bar – The status bar is located at the bottom of the main 
window and provides messages about Event/Alarm Viewer's current 
status, such as the presence of unacknowledged alarms.  

These controls are discussed in greater detail in the following sections. 

Where applicable, help icons appear below the cursor and in the status line at the 
bottom of the screen. These prompt an action or describe an object when the cursor 
lingers over an object. 
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Menu Bar 
The Event/Alarm Viewer main window displays the following pull-down menus: 

 

Explanations of each menu and its options follow. 

File Menu 
The File pull-down menu is shown below. Descriptions of the File options follow. 

 

The File menu offers the following standard Windows functions. 

• Open opens a previously saved list of events. 

• Close closes the currently active window, unless it is the last open view 
of a table. Event/Alarm Viewer requires that at least one Alarms 
window and one Events window remain open at all times, and will not 
permit the last window to be closed. 

• Save As… saves the list of events appearing in the active window. 

• Print..., Print Preview, and Print Setup... are all standard Windows 
functions relating to printing the active window. 

• Exit is the standard Windows function for closing the Event/Alarm 
Viewer application. 

In addition to these standard functions, the Configure item is where you specify 
which window is opened when Event/Alarm Viewer is started (Sequence of Events 
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is the default). Click on the desired window in the list of Available Windows, then 
select OK. That window will open first when Event/Alarm Viewer is next started. 

 

Edit Menu 
The Edit pull-down menu is shown below. The functions provided by the Edit 
options are as follows. 

1. Acknowledge – acknowledges a selected alarm in the active window. 

2. Delete – deletes a selected event or events from the active window. 

3. Select All – selects all events in the active window. 

 

View Menu 
The View pull-down menu is shown below. The functions provided by the View 
menu options are as follows. 
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1. The options available in the first block of the menu (Sequence of 
Events through EXPR Events) open the corresponding event window 
on top of the currently displayed window. The currently open event 
windows are not closed. 

2. SQL Queries opens the following dialog box, which allows you to 
add, delete, configure, modify, or execute an SQL query of the 
database. 
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To add a query, enter the name in the New Query text box, and click on 

Add, which puts it in the list of SQL Query Names. Select the new 
name, then click on Configure, which opens the Define SQL Query 
dialog box: 

 

When the query expression is completed, press OK to return to the SQL 
Queries dialog box. To run the query, click on Execute, after which a 
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new window is opened displaying all events matching the specified 
conditons. 

3. Status Bar shows or hides the status bar at the bottom of the main 
window. 

Settings Menu 
The Settings pull-down menu is shown below. The two main options are described 
below. 

 

Display Options 
The three suboptions available under this menu item are as follows: 

1. Selecting Settings: Display Options: Colors displays the dialog box 
shown below. You may assign display colors to each item type 
displayed in Event/Alarm Viewer’s windows. Each item’s current 
display color is shown to the right of its name.  
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 To change the display color of an item, click on the item’s button. The 
color selection palette is displayed. Click on the desired color and press 
OK. To exit without changing the color, click on Cancel. If you don’t 
see a color that appeals to you, click on Define Custom Colors and you 
will have an opportunity to create your own custom color. 

NOTE: Depending on your system’s video driver and color resolution capabilities, 
the colors on the Event/Alarm Viewer screens may not exactly match the colors 
shown in the color selection dialog box. 

2. Selecting Settings: Display Options: Time displays the dialog box 
shown below. Click on the checkboxes to display the date and/or time 
in event listings and choose from the formats available for each in the 
pull-down lists. Another pull-down list allows you to select the time 
sequence (ascending or descending) in which events are displayed. 

PMCS EventServer User’s Guide Chapter Four – Event/Alarm Viewer Menus and Toolbars  •  43 



 

3. Selecting Settings: Display Options: Events displays the Sequence of 
Events dialog box, as shown below. This box allows you to choose the 
types of events to be displayed and what information is to be included 
for each event displayed. 

 In the Event Display Options field, place a check mark next to the 
types of messages and events you wish to see displayed in the selected 
(active) Sequence of Events window. 

 In the Column Display Options field, place a check mark next to the 
columns of data you wish to see displayed in the selected (active) 
Sequence of Events window. 

 

Refresh Options 
This option displays the Refresh Parameters dialog box, as shown below. You can 
select the number of records to be displayed, the interval in seconds for refreshing 
the events display, in addition to turning the refresh option on or off. 
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Window Menu 
The Window pull-down menu provides the following functions: 

• The Cascade, and Tile options are standard Windows functions. 

• Numbered items list the currently open windows. Select a window 
from this list to bring it to the front and make it the currently active 
window. 

Help Menu 
The Help menu offers standard Windows functions to view help for the 
Event/Alarm Viewer program. 

The About EventLog... dialog contains the program version and copyright 
information. 

PMCS EventServer User’s Guide Chapter Four – Event/Alarm Viewer Menus and Toolbars  •  45 



Toolbar 
The main Event/Alarm Viewer window toolbar contains the following icons: 

 

Click on an icon to perform the corresponding action, as described in the table: 
Button Function/Description 

 
Opens the Sequence of Events window. A selected set of events and alarms are displayed in sequential 
order, with the most recent displayed first.  

 
Displays the Events window; only Device Events are displayed, most recent first.   

 
Displays the Alarms window; only Device Alarms are displayed, most recent first. 

 
Displays the System Events window; only System Events are displayed, most recent first. System 
Events include such things as a user logging in or out of the system, a device or communications port 
failure, or a waveform capture failure.  

 
Displays the Waveform window; only Waveform events are displayed, most recent first. Waveform 
events record the successful completion of a waveform capture. 

 
Displays the Annunciator Panel window; only Annunciator Panel events are displayed, most recent 
first. Annunciator Panel events include any device events which affect the Annunciator Panel tiles, as 
well as any events initiated by the Annunciator Panel Wizard. 

 
Displays the Faults window; only Fault events are displayed, most recent first. Faults are events such as 
line faults or ground faults recorded by certain fault-sensitive devices. These devices are the LPS, the 
ALPS, the DFP100, the DFP200 and the SM-3. 

 
Opens the Configure Sequence of Events window, enabling you to configure the set of events to be 
displayed in the Sequence of Events window. You can open the same dialog box by selecting File: 
Configure: Sequence of Events Config. 

 
Prints the currently active window on the configured printer. 

 
Opens the About dialog window. 

 
Displays HMI device type events. 

 
Displays acknowledgable events. 

 
Displays user-defined events. 

 
Enables the refresh function to update the events displayed in the active window at a predetermined 
interval. 

 
Disables the refresh function. 

 
Displays the SQL Queries dialog box. 

Table 1. Toolbar Icons. 

Security Support 
Event Server can be configured with password protection to acknowledge or delete 
events. To change whether a password is required, use the following procedure: 
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1. Open the Windows Run dialog box (from the Start button), enter 
regedit into the Open: text box, and click on OK. 

2. In the left side of the Edit Registers window that appears, select the 
follaowing directory path: 

HKEY_LOCAL_MACHINE\SOFTWARE\GE\PMCS\6.0\DataBase\Admin 

3. In the right side of the window, look for EVPassword. If its current 
value is “0”, then password protection is turned off (this is the default), 
while “1” indicates that it is on. To change the setting, double-click on 
the EVPassword icon. 

4. In the Edit String dialog box, set the desired value (0 or 1), then click 
on OK. 

5. To set or change the password, double-click on the EL Password icon, 
enter the desired password in the Edit String dialog, then click OK. 

6. Close the Edit Registers window to save the changes, which are 
effective immediately. 

Whenever any user attempts to perform an action that is password protected, the 
Enter Password dialog box appears. Enter the current password and click on OK to 
proceed with the protected action. 

To change the password, either use Edit Register as described above, or enter the 
password in the Edit Password dialog, then click on Change Password. Another 
dialog appears in which you are asked to enter the new password twice, then click on 
OK to confirm the change. 
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Chapter Five - Troubleshooting 

DDE Error 

 

Several different error conditions may result in a System Event message such as the 
one shown above. The table below lists causes of DDE errors and corresponding 
corrective actions.  

 
Possible error Solution 
The PMCS DDE/OPC 
Server was not started 
prior to starting Event 
Logger. 

Exit the Event Logger application, start the PMCS 
DDE/OPC Server, then restart Event Logger.  

A topic name was 
misspelled at the Event 
Logger. 

Correct the topic name to exactly match the spelling of 
the topic at the DDE Server. 

A topic was not 
configured correctly at 
the DDE Server. 

Correct the DDE Server configuration. See GEH-6510 
for details on configuring the PMCS DDE/OPC Server. 

A topic link failed under Use the Retry Failed DDE command from the File
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Possible error Solution 
NetDDE operation. menu. If this does not succeed, check the PMCS host 

machine to be sure that it is operating correctly. 

Cannot exit the Event 
Server application. 

If the Event Server was installed as an NT Service, the 
only way to close the application is through the Services 
applet in the Windows Control Panel. Only users with 
Administrator privileges may start and stop services. 

Table 2. Troubleshooting table for DDE errors. 
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ODBC Error 
Note: As part of PMCS Eventserver supports only MSDE database. The information 
mentioned under this section would, not be relevant to PMCS 

An ODBC error means that Event Logger is having problems gathering requested 
data from its database files. This may be caused by an invalid filter query, by 
misplaced Event Logger database files, or because ODBC has not been setup yet or 
was set up incorrectly. 

If an ODBC error occurs when the Event Logger is started, check the ODBC setup 
as described in the Introduction section to make sure that the version of ODBC is 
correct and that it points to the EVENTLOGGER.MDB database file.  

If you are attempting a query, verify that your filter is valid and formatted correctly, 
then retry the query. 

If the ODBC error still occurs, check the EVENTLOG directories for the following 
file: 

GE_PMCS\EVENTLOG\DATABASE\EVENTLOGGER.MDB 

If this file is missing, Event Logger will display an ODBC error message.  

Locate and restore this file to the EVENTLOG\Database directory and restart Event 
Logger. A backup copy of a blank database is included on the PMCS CD under the 
BACKUPS directory. If it cannot be found, re-install the Event Logger software to 
create a new database file. 

NOTE: Microsoft Office 2000 users: if you install Office 2000 after installing 
PMCS you may experience ODBC errors and other database problems with the 
EventLogger. This is due to incompatibilities between the PMCS applications and 
the new ODBC drivers installed as part of Office 2000. To correct this, shut down 
PMCS and replace the Eventlogger.mdb and Eventlogger_blank.mdb files with files 
from the Backups\Office 2000 directory located on the PMCS CD media. Installing 
PMCS on a computer that has Office 2000 installed already avoids this problem as 
the PMCS installation recognizes the new ODBC drivers and configures PMCS 
appropriately 

 

Adjusting Printer Font Size 
Event Logger windows are printed with the system font. The default font size is set 
to 4 and the default printing mode is set to Landscape. This allows the maximum 
amount of information to be printed on a page.  

If you are experiencing printing problems or difficulty reading Event Logger 
printouts, the font size can be adjusted as follows: 

1. Open the Windows Run window (from the Start button), enter regedit into the 
Open: text box, and click on OK. 

2. In the left side of the Edit Registers window, select the following directory path: 

HKEY_LOCAL_MACHINE\SOFTWARE\GE\PMCS\6.0\EventViewer 
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3. In the right window, double-click on PRINTERFONTSIZE. In the Edit String 
dialog box that appears, change the font size to the desired value. 

Blank Event Cause 
If a configured device's event strings have not been properly set up, all events will 
display a blank event cause. This can be remedied by following the device 
configuration procedure described in Configuring Device Types. 
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